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PREFACE

Rapid changes in the marketplace, in data, and in the computing envi-
ronment are transforming the structure and content of the marketing
manager’s job. As a profession, marketing is evolving so that it is no
longer based primarily on conceptual content. While many view tradi-
tional marketing as an art and some view it as a science, the new mar-
keting increasingly looks like engineering (that is, combining art and
science to solve specific problems).

There will always be a role for marketing concepts. Indeed, to make
use of the powerful information tools now available requires sound con-
ceptual grounding. But marketers need more than concepts to fully ex-
ploit the resources available to them. They need to move beyond con-
ceptual marketing toward what we call marketing engineering: the use of
interactive computer decision models to help support marketing deci-
sions. While such needs are evident throughout the field of marketing,
they are central to effective marketing research.

This package of materials is designed to supplement a course in
Marketing Research. It includes selections from our book, Marketing
Engineering (Addison Wesley Longman, 1998) that are appropriate for
such courses. Those selections are designed to make the corresponding
course material come alive with hands-on exercises and cases.

Although each piece of software included here has associated with it
a corresponding case or problem, all of the software (except the Promo-
tional Spending Analysis spreadsheet) is independent of those cases and
can be used separately on other case-problems or on real problems.
Two of the software programs—TreeAge and Scan/US—are supplied as
student versions of commercial packages, whereas we developed the
other five pieces of software.

We have selected seven tools and applications that have broad rele-
vance in marketing research courses:

1. Needs-based Segmentation Using Cluster Analysis: This general
software tool performs cluster analysis, factor analysis and discrimi-
nant analysis. The accompanying case addresses how to segment
the market on the basis of needs for a sample of prospective buyers
for a new personal digital assistant. The case raises issues such as:
(1) How many segments should the firm consider (and how do those
segments differ)? (2) Which of those segments should the firm tar-
get? (3) How many different products should the firms offer? 4)
How should the new product be positioned? (See Positioning Analy-
sis, below.)

2. Targeting: Using Regression and Multinomial Logit Analysis:
This software tool allows the user to apply both regression and logit
analysis to a customer targeting application: developing a direct
mail campaign that targets the best/most responsive customers. In
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its application to the Bookbinders' Book Club case, it allows the stu-
dent to compare a "judgmental” targeting approach with the results
of a regression based as well as a logit-model approach.

3. Product Positioning Using Perceptual Mapping: This software
tool takes customer perceptions and preferences for products and
produces a two or three dimensional map that allows the user to
view alternative product positions and consider the strategic impli-
cations of changes in that positioning. The accompanying case
looks at positioning the Infiniti G20 in 1990: given customer per-
ceptions and preferences for new cars in 1990, how should Infiniti
position this car in the market. (We also include a data set that is
related to the PDA segmentation case.)

4. Product Design Using Conjoint Analysis: This software imple-
ments the full-profile version of conjoint analysis. The program al-
lows users to: (1) Construct the conjoint design by specifying new
product attributes and options. (2) Obtain data from customers for
the chosen design. (3) Conduct market simulations using data from
customers to determine the product design(s) that will generate the
highest market share(s). We include a hotel design exercise for forte
Hotels to illustrate the use of conjoint analysis.

5. Making Decisions Under Uncertainty Using Decision Trees
(TreeAge): The software permits easy implementation of decision
trees to isolate the factors that have the most influence on decisions
that have uncertain consequences. The software also allows the stu-
dent to determine the value of marketing research that may reduce
the decision uncertainty. We include a case: ICI America's Product
Selection case, where the concepts and tools can be applied.

6. Retail Site Location Using Geodemographic Data and Models
(ScanUs): Geodemographic data, in conjunction with a gravity
model can be used to determine the relative attractiveness and mar-
ket potential of different retail sites. The associated case—J&J
Video Store location—illustrates how this important new data
source and related computer tools can be used.

7. Promotional Analysis Using Scanner Panel Data and Multino-
mial Logit Analysis: Scanner panel data—an increasingly perva-
sive data source—can be used in conjunction with a modeling
framework like logit analysis to evaluate promotional effectiveness
and develop promotional plans for packaged goods. The associated
case, MassMart Inc, demonstrates how these concepts and tools can
be applied to improve the profitability of promotional plans.

The pedagogic philosophy here involves two main principles: learning
by doing and end-user modeling. What this means is that the way you
will learn these concepts best is to try to apply the software to the prob-
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lem and make some specific recommendations based on your experi-
ence. Thus you learn the concept by doing it yourself—not merely by
studying the concept or by assigning the analysis to some staff member
or consultant.

This volume contains both software tutorials (step by step instruc-
tions on how to use the software) as well as the problem sets or cases
that are keyed to the concept. We strongly recommend that you go
through each tutorial (making sure you can reproduce the results there)
before attempting to “solve” the case. Our experience is that well over
90% of the difficulties users have running the software are solved by
simply reproducing the screens in the respective tutorial.

Also, read the first section of this tutorial carefully—it not only tells
you how to install the software, but it provides a number of other general
hints about using the software.

To get other software hints and updates, please visit our website:
http://hepg.awl.com/lilien-rangaswamy/mkigeng/. You can also send us
your comments and suggestions about the software by using the e-mail
facility available at this site.
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INTRODUCTION

MARKETING RESEARCH SOFTWARE (VERSION 1.0)

Installing Marketing Research: Marketing Engineering

Applications

Installing the software onto your computer’s hard disk is an easy proc-
ess, but you should still read through the entire installation instructions
before you start.

A. This software is supplied to you on a CD-ROM. Before you start,
make sure that you have the proper hardware and operating system:

Minimum configuration: IBM-compatible PCs running the 486
processor (33 MHz), 16 MB RAM, 15 MB available hard disk
space, and a CD-ROM drive.

Recommended configuration: IBM-compatible PCs running the
Pentium or equivalent processor (133 MHz or better), 32MB RAM,
15 MB available hard disk space, and a CD-ROM drive.

Operating system: Windows 95 and Windows NT.

Microsoft Excel: Parts of this software require the availability of
Microsoft Excel 7 or higher. If you have not installed Excel on your
system, you may still be able to use the non-Excel models included
in this package.

B. Installing the software
1. Start Windows.

2. Insert the Marketing Engineering CD-ROM into your CD-ROM
drive.

3. Run the setup.exe application in drive x:\, where x is the letter of
your CD-ROM drive.

4. Follow the instructions on the screen to complete the installa-
tion. We recommend that you install this program in the default
directory C:\Program Files\MktgEng, although it will work on
any non-network (local) drive.
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C. Uninstalling the software
1. Start Windows.
2. Open Control Panel.
3. Open Add/Remove Programs.

4. Select Marketing Engineering. Click Add/Remove button.

Required add-ins for running Excel applications

For Excel applications, you need the Solver tool. Solver is not part of the
default configuration when you install Microsoft Excel. Under the Tools
menu on your version of Excel, check the list of Add-Ins to see whether
they are included. If not, run the Excel (or MS Office) setup procedure
(with the original installation disks or CD) and select the appropriate
options to install Solver.

Setting up Marketing Engineering after installation

Setting preferences: If you wish to customize the location of the files
used by the program, go to the Help menu and select Preferences. In
particular, make sure that the path to Excel.exe is correctly specified.

Path to Microsoft excelexe Ic:\msollice\eicel 4'
Path to Excel Spreadsheets Fz\mklgeng\excel

Path to Data Files ‘Ic:\mklgeng\data

Path to Temporary Files Ic:\mktgeng\lemp ]
Path to Conjoint Data Files |c:\mklgeng\conioint\data l

I Installed on Network? |7 Auto Stait Excel?) - Browse |

ok |  Cocel | | Heb |

You can install the software on a network only with the network
version of Marketing Engineering. If you check Auto Start Excel, the
program will automatically start Excel every time you open Marketing
Engineering. If you turn off this option, you can still open Excel when-
ever you want to by going to the File menu and choosing Open Excel.
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Opening applications: When you start Marketing Engineering, you
will briefly see the following screen:

e———
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Gary L. Lilien and Arvind Rangaswamy
On the Model menu select a model, e.g., Positioning Analysis.
NOTE: Only models that appear as active menu items can be opened.

The non-activated items are part of the full Marketing Engineering suite
of programs.
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% Marketing Engineering Application

@ ADBUDG: Advertising Budgeting [XL) GE: Portfolic Planning (XL)
ADCAD: Ad Copy Design Leaming Curve Pricing (<L)
ADVISOR: Communications Planning (XL) Mulinomial Logt Analysis
Analytic Hierarchy Pracess i Neural Net Forecasting
ASSESSOR: Pretest Market Model (L) Postioning Analysis
Bass Model (XL] -PIMS: Strategy Model (XL]
Choice-based Segmentation (XL) Promotional Spending Analysis (XL)
Cluster Analysis : | - CALLPLAN: Safes Cafl Plarming (<L)
Compelitive Advertising (XL) Jal | - 'Seles Resource Allocation (XL)
Competitive Bidding (XL) % Yaluem-use Pricing (XU

Conglomerate Promotional Analysis (Xl{.]i Visual Hesponse Madeling (XL)

“Yield Management for Hotels (XL)
Userdefned ()

Decision Tree Analysis
Geodemographic Site

Run Advertising budgeting model (Excel spreadsheef)

Tips for using the software

Marketing Engineering consists of three different types of software
modules:

1. Windows-based programs that will run directly off the Marketing
Engineering main menu:

= Cluster Analysis
=  Multinomial Logit Analysis
= Positioning Analysis

2. A spreadsheet model that will be loaded under Excel:
= Promotional Spending Analysis

3. Stand-alone applications that are “loosely” connected to the main
menu and are simply executed when invoked:
= Conjoint Analysis
= Decision Tree Analysis
= Geodemographic Site Planning

Select Index under the Help menu to get information about individ-
ual models and how to run them.

NOTE: The following tips apply only to Microsoft Excel applications
(Promotional Spending Analysis).

Opening Excel models directly: You can open Excel models directly
by clicking on *.xls files located in the (default) directory, C:\Program
Files\MktgEng\Excel. This can be helpful if you have limited memory on
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your computer system to load the full Marketing Engineering program. If
you move the Excel files to a new directory, make sure that the file
modgen97.ind is also located in the new directory.

Moving between the main Marketing Engineering window
and an Excel application: To move back and forth between the
Marketing Engineering main window and an Excel application you can
use the ALT+TAB key combination. You can also get back to the Mar-
keting Engineering main window from an Excel application by going to
the Model menu and clicking Back to Mktg. Eng.

| Liod- [

Main Menu
Introduction
Analysis Area

Entering data into a Excel spreadsheet: After you enter data in a
cell, press the Enter key to ensure that the data gets registered within the
spreadsheet.

Using Solver: In some cases the Solver runs in Excel will not con-
verge. You may then have to provide Solver with new starting values.
See Appendix at the end of the section of tips for using Solver.

Unprotecting locked cells: 1f you want to make changes to locked
cells or if you want to unprotect the spreadsheet for certain Solver runs,
go to the Tools menu, select Protection, and click Unprotect.

Saving Excel files: 1f you want to save any of the Excel spreadsheets
that you modify, save it in the same directory (default: C:\Program
Files\MktgEng\Excel) in which the other Excel files are located.

Non US Versions of Excel: Much of our code assumes that you will be
using English/American conventions for numbers and currency. The
most critical problem is the difference between the use of the “.” and the
“,” to refer to decimals depending on the country you are in. You must
use US conventions in your input and you must make the following sys-

tem modifications to run the programs with a non-US version of Excel.
First, Close any open programs.

Next, Click the Start Button, point to Settings, click Control Panel.
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Next, Double Click Regional Settings.

€3 Control Panel [ _ O] x|
fle Edt VYiew Hebp

Bl W Ok 8 &

Accessibilty  Add/Remove Console Date/Time Devices Display

Options Programs
; = 3 D 4
S R
Fonts Internet Keyboard Modems Mouse Multimedia
#2 F 9 2!
Network opBC PC Card Ports Printers Feqons
(PCMClA) Setting
¢ &8 % 4 53
SCS| Adapters Server Services Sounds System Tape Devices
Telephony UPsS
Iﬁwlge:lheappearmdmrbas,umencies,dm,mdhu —

Select English (United States) as indicated below and first click Apply
and then OK:

i Regional Settings | Number | Curency| Time | Date | Input Locales |
; Mwmmwtdanﬁﬂsd&u&ﬂmlheﬁegnnd -

Settings affects the way these programs display and sort dates, times,
currency, and numbers. '

Enalizh [Lnited States]

[T Set as system default locale

0K I Cancel | Apply |

(You may be requested to insert the Windows CD at this time.)
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Select the Number and Currency tabs and check to see that the US con-
ventions are now applied.

Regional Settings Properties | 2] Zﬂ

Regional Settings| Number | Cunency | Time | Date .| Input Locales |

1 Appearance samples : :

| erosiiv& [123456 78300 | Negative: [123.456.783.00
Decimal symbot . | El

{ o

| No.of digits alter decimat  [2 =]

Digit grouping symbot [ ~|

' No of digits in group: S E ~|
Negative sign symbot I ~]
Negative number format: |-1.1 EI

- Display leading zeros: Jo7 |-

% List separator: i II vI i

i Appeaa-ncesmples‘ ._.; -
] [Poshve |$1 23.456 78900 3 Negative: I[$123,'45B,?BS.00]
‘ s d ),
; _

T

{ ﬂsUniversalwnemyswbd Sl o A
, Currency symbol: lﬂ 'I
: Positive currency format | H1.1 ;j
; Negative cunrency format: |[Ii1 1) EI
Decimal symbol: | =l
No. of digits after decimal: |2 EI
Digit grouping symbol: I LI
No. of digits in group: I3 EI
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After you have completed these changes, Click the Start Button again,
then click Shut Down and Click Restart the Computer and finally
Click OK.

This procedure will allow you to run our software.

Be sure to reset to your local conventions when you are done using our
software!

NOTE: The following tips apply only to software modules that run di-
rectly off the main menu, namely, Cluster Analysis, Multinomial Logit
Analysis, and Positioning Analysis.

Incorporating your own data sets: There are three ways to create
new data sets for Cluster Analysis, Multinomial Logit Analysis, and Po-
sitioning Analysis.

1. Load an ASCII file containing the data in the appropriate
format: Use a standard word processing program to generate a text
file that can be directly read by the Marketing Engineering program.
The format for the file follows:

Perceptual Mapping Line 1
34 Line 2
566.04.63.6 Section 1
44365222
29642726
Sprint Section 2
MCI
AT&T
Other
Value Section 3
Service

Special Programs

Line 1: Enter title of data set

Line 2: Enter the number of rows and the number of columns of data
Section 1: Enter the data (separate by comma or space)

Section 2: Enter column headings

Section 3: Enter row headings

You can load this file into Marketing Engineering by selecting
File, followed by Open. You will be prompted for the file name.

2. Import data from Excel: First, open the Marketing Engineering
program. From the File menu, select New.
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pen... Cul+0

[jpen Exée[ e

Exit

Enter a file name and click OK to see the following screen.

New Marketing Engineering file P

Title IPerceptuaI Map J

vowe [] ot [

Enter a title for the data and the number of rows and columns.
Click OK.

Next, separately enter or import a data set into Excel (just the
data, no labels) as shown below:

N\ Micresoft Excel - Book1
ﬂﬂe Edt View [nset Format Jools Data Window Help

D= |§|&|7|$]h|&|~§|2|2|_£]£._|__]_
faia :Jl1ﬂljn|1|n|IE:sl_J

E3 ~|
A | B | € | D | E | ]
1| 56 3 46 36
(2] 44 36 52 22
E 29 6.4 27 28] |
4

You can now import the data from Excel into Marketing Engi-
neering in one of the following two ways:

Copy and paste the data directly into Marketing Engi-
neering. In Excel, select the data range you want to import into
Marketing Engineering. From the Edit menu use Copy or Cut to
paste the data to Windows clipboard. Use the ALT+TAB key com-
bination to get to the Marketing Engineering window. Place the
cursor on the first row and first column of the blank spreadsheet and
paste the data from Excel onto the Marketing Engineering work-
sheet. If you want to override the default column and row headings,



